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Abstract

Plants must adapt to environmental constraints. For this, they are able to perceive several types of stress in isolation or in
combination manner. At the cellular level, after the perception of stress, cell signaling is set up to allow the establishment of
the specific response. The calcium ion is known to be one of the ubiquitous second messengers which is involved in most of
the stresses perceived by the plant. Changes of free cytosolic calcium but also in other cellular compartments are able to
activate or inactivate several mechanisms involved in the cell to cope with the changes of environmental conditions. Several
calcium reporters have been intensively used to visualize calcium signals in different conditions.  In this chapter,  we will
present only genetically encoded fluorescent reporters for calcium imaging in living plant tissues to measure variations in
calcium at several scales. The FRET (fluorescence resonance energy transfer) YC3.60 and the intensiometric GCamP3 sensors
will  be used in this method chapter. The image analyses will  be also detailed for fluorescence  quantification of calcium
variation.
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1. Introduction
The calcium ion is a ubiquitous second messenger in cells and changes of free calcium concentration have been studied for
several decades for its role in cell signaling. Thanks to calcium imaging, the role of calcium in cell signaling has been described
in detail, and the “calcium signature” concept has emerged to encode specific information that is relayed to downstream
signaling events. Calcium signals have been imaged with different fluorescentce dyes in animal cells and to some extent in plant
cells. However, the use of calcium fluorescentce dyes shows some limitation of permeability due to the plant cell wall and to
subcellular targeting. Later on, the genetically encoded fluorescent reporters that have been generated have made it make much
easier to carry out calcium imaging. Then the introduction of genetically encoded calcium indicators (GECIs) into plants has been
successfully done, thus allowing to measure free calcium changes in different tissues or whole plants. There are two types of
GECIs: bioluminescent and fluorescent ones. The first type does not require excitation by light, but needs a cofactor. The well-
known bioluminescent GECI is the aequorin from jellyfish and possesses three calcium-specific EF-hand domains. Upon calcium
binding, aequorin emits one single photon that can be collected for calcium quantification. The apo-aequorin sensor is the first
GECI used in plants and allows to show calcium signals in response to abiotic stress [ 1 ]. Its low-light emission is a limit for
visualizing easily calcium signals in plants with a microscope, and it is more dedicated for whole plant calcium monitoring with a
luminometer device [ 1 ]. Improved bioluminescent sensors working by bioluminescence resonance energy transfer (BRET) have
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been successfully engineered and several bioluminescent sensors showed an up to fivefold increase when compared to aequorin
[ 2, 3 ]. However, bioluminescence calcium imaging is still difficult without a dedicated camera that has the capacity to detect a
single photon. The development of fluorescence-based GECIs has deeply changed calcium signaling studies in plants. The FRET
(fluorescence resonance energy transfer) YC2.1 sensor has been one of the calcium reporters successfully used with microscopy.
One major example of its use has been the study of the cytosolic calcium variation in stomatal guard cells induced by the plant
hormone abscisic acid [ 4 ]. An oscillation signal has been measured with an optimal pattern of cytosolic calcium increase and

period parameters for triggering stomatal closure [ 4 ]. The FRET sensor is composed of two fluorescent proteins (FPs), CFP (cyan
FP), and YFP (yellow FP), linked by a calmodulin (CaM) and its M13 synthetic peptide target sequence. Upon calcium binding,
conformation is changed in a way that allows FRET events between CFP and YFP. Then, the CFP fluorescent signal decreases,
whereas the YFP signal increases during the FRET that reflects free calcium level increase. FRET sensors have been improved to
give a better dynamic range to visualize small calcium variations by replacing the fluorescent partners CFP and YFP by cerulean
FP and Venus FP, respectively. The modification improves the FRET efficiency [ 5 ]. Another FRET sensor, YC3.60, has a good

dynamic range and has been used in diverse plant cell types such as guard cells, pollen tubes, and root hairs [ 6, 7, 8 ] or in

different subcellular compartments such as chloroplast, mitochondria, and peroxisomes [ 9, 10, 11, 12, 13 ]. A low affinity sensor
was also designed in order to measure calcium levels in different compartments with a high calcium concentration such as
endoplasmic reticulum [ 14 ]. Another type of fluorescent calcium sensor, the GCamP sensors, consists of circularly permuted

green fluorescent protein (cpGFP), CaM, and CaM-interacting M13 peptide [ 15 ]. These sensors thus retain CaM and the M13
peptide as calcium sensor, but they are much simpler and easier to use. The GCamP sensors are mono-excitation and mono-
emission and do not need sophisticated devices to detect increases of free calcium concentration. The dynamic range is also
much higher than YC3.60 and contributes to the improved calcium signal detection at lower magnification for long distance
calcium imaging. This type of intensiometric sensor was expanded to red and blue color to create the R-GECO-1 and B-GECO1
indicators [ 16 ]. The single fluorescent protein-based Ccalcium  indicators GCamP3 and R-GECO1 were successfully introduced

in plants [ 17, 18 ] and have become the most popular calcium sensors used in plants. These fluorescent reporters are able to
visualize calcium changes in many conditions and contribute to highlighting the role of calcium in plant signaling. However,
these intensiometric sensors show some weakness due to the absence of a reference for the fluorescence normalization over
time, whereas the FRET ratiometric YC3.60 shows more accuracy. Nevertheless, the choice of calcium reporters is dependent on
the magnification needed for the observation and the imaging systems available for the acquisition. Here we describe in detail
the protocol to use either the ratiometric YC3.60 or the intensiometric GCamP3 for different magnification observations. The
image analysis for the quantitative determination of calcium signals will be also described.

2.Materials

2.1. YC3.60	Transgenic	Plants
The Arabidopsis thaliana  (Col-0 ecotype) transgenic plants harboring the cytosolic NES-YC3.60 and sensor are described in
Krebs et al. [ 11 ]. The reporter is expressed under the ubiquitin 10 promoter. Seeds of transgenic lines are plated on 0.5× MS
media complemented with 1% sucrose (w/v) and 0.7% agar (w/v). Seedlings are growing under 120 μmol/m /s for 16 h of light
at 21 °C for 6 days.

The 6-day-old seedlings of YC3.60 transgenic line are mounted between two coverslips with a thin layer of agar 0.5%. The
primary root has been then imaged with CFP, FRET, and bright-field channel acquisitions.

2.2. GCamP3	Transgenic	Plants
The Arabidopsis thaliana  (Col-0 ecotype) transgenic plants harboring the GCamP3 sensor are described in Nguyen et al. [ 18 ].
The reporter is expressed under the ubiquitin 10 promoter. For the GCamP3 line, seeds are directly sown on soil. Condition of
growth is 16 h of light, 2 °C and 120 μmol/m /s. After 4 weeks, leaves are detached and left on water for recovery. The
detached leaves have been imaged under the macroscope, and 100 μL of solution were dropped on the petiole to trigger a
calcium signal. Three image tiles were acquired to see the entire leaf during calcium imaging.

2.3. Solutions

1. Ferrozine (Fe iron chelator) solution is dissolved in water at 100 mM stock solution and stored at −20 °C.

2. Solutions of 10 mM of CaCl  and 100 mM of NaCl were both prepared in water and kept at room temperature.

2.4. Equipment	for	FRET	YC3.60	Microscopic	Measurement
The images have been acquired with an inverted microscope Axiovert 200M (Zeiss) equipped with the following:

1. A halogen lamp with an external shutter for bright field acquisition.
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2. Spectra 7 light-emitting diode (LED) illumination source with the 438/24 nm excitation.

3. Beam splitter (BS) 458 nm.

4. Objective lens 5X EC Plan-Neofluar/0.16 NA and 20X A Plan Apochromat/0.3 NA.

5. External filter wheel (Sutter lambda 10-B) for dual emission with the Bandpass (BP) 480/40 nm and BP 535/30 nm filters.

6. Camera Coolsnap HQ (photometrics).

7. Metafluor software 7.5 (molecular device).

2.5. Equipment	for	GCamP3	Microscopic	Measurement

1. AxioZoom V16 macroscope (Zeiss) with objective PlanNeoFluar Z 1.0x/0.25.

2. LED source Xylis (Excellitas technology).

3. LED source CL9000 (Zeiss) with gooseneck light guide for bright-field illumination.

4. Filter wheel with filters set for excitation at 470/40 nm, BS 495 nm, and emission at 525/50 nm.

5. Camera Orca Flash 4.0LT (Hamamatsu).

6. Zen blue 3 software.

3.Methods

3.1. FRET	YC3.60	Microscopic	Measurement

3.1.1. Acquisition	Settings
The setup is designed for single excitation and dual emission recording. A time lapse is done with a sequential acquisition
between the FRET, CFP, and BF (bright-field) channels.

1. Channel 1 (FRET channel) was imaged with excitation at 438/24 nm and emission at 535/30 nm with 295 ms exposure
time (see Note 1).

2. Channel 2 (CFP donor channel) was imaged with excitation at 438/24 nm and emission at 480/40 nm with 300 ms
exposure time (see Note 1).

3. Channel 3 for BF was imaged with 100 ms exposure time.

The image sequences are acquired with the cool snap Coolsnap camera (Subheading 2.4 ) set at 12 bits with a binning of 2

(see Note 2). Binning combines adjacent pixels that are read out together as a super pixel rather than reading out the data of
each individual pixel. Pictures have been taken every 10 s. Metafluor 7.5 software was used for acquisition.

During the acquisition, 100 μL of treatment solution was added gently to induce calcium signals (Figs. 1  and 2 ) (see Note 3).

Fig. 1

Ferrozine induces an increase of both free calcium level and speed of root growth. The primary root of YC3.60 plant was
exposed to 500  μM iron  chelator  Ferrozine  at  3  min (black  arrow)  after  the beginning of  calcium  measurement  was
assessed.  Images are acquired every 10  s  during 18  min.  Pictures of  FRET/CFP ratios every 3  min are shown in (a).  A
kymograph  on the root  is  shown in  (b)  to  highlight  root growth  and calcium  signals  along the root  (b).  Bright-field
pictures of the root  and its corresponding kymograph are shown in (c) and (d). Calcium variation on the entire root  is
shown in  (e,)  (red  curve)  and averages  of  root growth  every  3  min are  plotted on the  same chart  (ee,  box plot,  e).
Correlation between root growth rate and increase of free calcium level can be seen in (e) after application of ferrozine at
3 min (ee, black arrow). Scale bar = 50 μm
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Fig. 2

External calcium application induces calcium oscillation in the root. The primary root of YC3.60 plant is exposed to 10 mM
of CaCl  and changes of calcium levels are measured with the FRET sensor every 10 s during 40 min. Standard deviation
projection over  time shows the localization of  calcium  changes in  (a).  Three regions of  interest  (ROI)  are  selected for
kymograph representation in (b). The oscillation signal is then observed after 1 min for 40 min. The quantification of the
signal for the three ROI is shown in (c). Scale bar = 20 μm

YC3.60 sensor has been used to monitor calcium changes in Arabidopsis root in response to different types of stimuli. Figure

1  shows that iron chelation in the medium induces an increase of the fluorescent signal along the root . The low

magnification used in this experiment (objective 5×) allows to correlate calcium variation and root growth. Figure 2  shows a

second example taken at higher magnification (20×). The increase of the resolution is suitable for analyzing calcium oscillation
induced by CaCl  in the medium at the level of root cells.

3.1.2. Image	Processing
Metafluor 7.5 software  creates one image per time and per channel. It is necessary to combine all the files of a time lapse in
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one stack image. This step is done for all the channels. The images are opened with the FIJI open-source image processing
package [ 19 ] by using the import image sequence process. Every channel (CFP and FRET channels) is opened separately with
FIJI, using the following commands:

File → import image sequence

1. Background Correction

A background region of interest (ROI) is selected from non-plant pixels with square tool selection. Backgrounds are subtracted
with the plug-in “Background subtraction from ROI” (see Note 4). The median filter is then applied with radius pixel = 2 (see
Note 5), using the following commands:

Process → filters → median

2. Registration

If the sample is moving (or growing) during the acquisition, a registration has been processed to align the images with the
plug-in Registration:

Register → Register Virtual Stack Slice (see Note 6)

Select the original image sequence and create a new folder for saving the new images.

Use “Rigid” as Registration model.

Save the transforms to re-apply it on the two other channels (CFP and FRET) prior to doing the ratio. Image registration has

been performed in Fig. 2  to avoid stack images shift during calcium measurement.

3. Ratio Image

The ratio of FRET/CFP is performed with the plug-in “Ratio Plus” (see Note 7). The thresholds of each channel are first
estimated prior to ratio calculation. A “Ratio Calculator” window is opened when the plug-in “Ratio Plus” is launched. Select
the two images (or stacks) as “image 1” and “image 2.” Fill the “Clipping Value1” and “Clipping Value2” with the threshold
values of each corresponding image or stack and press “OK.” The ratio will be performed as image 1 over image 2.

Save the stack ratio file as “Tiff” file.

3.1.3. Quantification
Calcium signal is quantified by first making a kymograph (or time-space plot). A segmented line or straight line is used to
select the region to be measured. Use the Reslice tool to create the kymograph of the ROI, using the following commands

Image → Stacks Reslice [/]

Save the kymograph as “Tiff” file.

On the kymograph picture, select the ROI to be quantified and plot the profile, using the following commands:

Analyze → Plot Profile

3.2. GCamP3	Macroscopic	Measurement

3.2.1. Acquisition	Settings
The detached leaf is placed under the 1× objective with a zoom of 7×. Three image tiles were necessary to see the entire leaf.

Sequential images have been acquired for the two channels.

1. Channel 1 (470/40 nm) was imaged with 200 ms exposure time, with light source intensity set at 30%.

2. Channel 2 (BF) was imaged with 2 ms exposure time.

The images are acquired in 16 bits with the Orca Flash 4 camera, and a binning of 4 was set (see Note 2).

Example of acquisition is shown at the macroscopic scale to visualize the calcium waves in the entire leaf of Arabidopsis

thaliana in response to salt stress (Fig. 3 ). A mosaic acquisition of three image tiles is taken every 10 s during 16 min.

Fig. 3
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NaCl induces calcium waves in detached leaves. The entire leaf is imaged by taking three image tiles every 10 s for 16 min
(a). Pictures at different times are shown after adding 100 μL of 100 mM of NaCl at the petiole  at time 0 s. Time (min) is
indicated in each image (a).  A pseudo color fire Look-Up Table (LUT) is used to reflect differences in intensity  (see the
calibration color bar at the right). Panel (b) shows a synthetic picture corresponding to the standard deviation projection
(STD)  of  the  signal  intensity  during  the  time  lapse  (right)  and  the  bright-field  (left)  acquisition  at  time  0   s  (left).  A
quantification of the signal (A.u. = arbitrary units) is done by drawing a region of interest (ROI) of the entire leaf (c). Scale
bar = 1 cm

3.2.2. Image	Processing

1. Stitching

When a mosaic picture is required for a very large sample, stitching is performed with Zen blue software (see Note 8) to
combine all the image tiles with a partial overlapping field of view.

Tiles are fused with the following settings: 5% of minimal overlap, maximal shift 10% (Fig. 3 ).

2. Background Correction

For macroscopic image, the background is subtracted in Fiji as follows:

Process → Subtract Background → Rolling ball radius = 50 pixels

This tool is appropriate for correcting an uneven background.

3.2.3. Quantification
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Calcium signal is quantified by measuring the fluorescence on the entire leaf with Fiji.

1. Select the leaf with “Polygone selections,” and add it as ROI in ROI manager, using the following commands:

Analyze → Tools → ROI manager

2. Select the leaf ROI in the ROI manager and measure mean values of each time point, using the following command:

More → Multi measure

3. The average of the mean gray value (a.u. = arbitrary units) is plotted vs time (see Note 9) (Fig. 3c ).

4.Notes
1. Exposition times for the channels have to be adjusted depending on the magnification lens in order to have a ratio equal to

1.

2. Binning will increase the signal, but decrease the resolution. Then, exposure time could be reduced. Choose a good balance
between signal and resolution.

3. Stress application has to be done without moving the sample. This is a critical step to have a good quantification. Then, the
volume to apply could be adjusted with slow application with the help of the micropipette.

4. Use the same ROI for the Background subtraction for each channel (FRET and CFP). The Background subtraction plug-in
could be applied several times to make sure that baseline is the lowest and is constant over time.

5. Application of median filter decreases the noise, but will blurry the picture. Alternative filters like “Gaussing Blur” could be
used.

6. Use first the bright-field channel for registration and save the transform file to apply it on the two fluorescentce channels.
Registration with the fluorescentce channel is not properly performed due to the fluctuation of the fluorescentcte signal.

7. Alternative solution is to use the image calculator tool in Fiji. Select the two channels and divide. Tick the “32-bit (float)
result” box to get decimal values, using the following commands:

Process → Image Calculator

8. Stitching is performed with Zen blue. If the stitching is not accurate, use edge detector to improve the stitching. Minimum
overlapping and maximal shift could also be changed to improve the stitching. An alternative solution is to use Fiji freeware
to perform the stitching manually with the plug-in “Mosaic J” [ 19 ].

9. To get the average values, make sure that measurement parameter is set properly, using the following commands:

Analyze → set measurement → tick the relevant setting (mean gray value)
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